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Apresentamos um software desenvolvido com o objetivo de proporcionar um melhor entendimento acerca do
comportamento de sistemas superparamagnéticos sujeitos a campos magnéticos externos, sem a necessidade de
conhecimento prévio em programação. O simulador reproduz o comportamento da magnetização em função de
diversas variáveis, tais como temperatura, magnetização de saturação e diâmetro médio dos momentos magnéticos.
O problema é abordado de forma simplificada através da função de Langevin. Nosso trabalho busca auxiliar no
estudo de materiais magnéticos nanoestruturados, normalmente de difícil abordagem experimental no âmbito do
ensino, assim também servindo de base para futuros pesquisadores da área.
Palavras-chave: superparamagnetismo, Langevin, simulador.

We introduce a software aimed to provide with a better understanding over the behavior of superparamagnetic
systems under external magnetic fields that does not require previous knowledge in coding. Our simulator generates
the magnetization behavior according to many variables such as temperature, saturation magnetization, and the
average diameter of the magnetic moment. The problem is tackled in a very simple way via the Langevin function.
Our work ultimately seeks to assist learning in nanostructured magnetic materials, quite often a bit hard to grasp
by many students, thereby also being of use for prominent researchers in the field.
Keywords: superparamagnetism, Langevin, simulator.

1. Introdução

A Física nos permite observar, descrever e entender a
regularidade dos fenômenos naturais. Entretanto, ferra-
mentas de ensino disponíveis são muitas vezes limitadas,
afetando a plenitude do processo de aprendizagem de-
vido a dificuldades na experimentação. Logo, a educação
está passando por mudanças consideráveis nas últimas
décadas. A experimentação através de simulação tem
sido amplamente utilizada na construção de materiais
didáticos [1–4]. É neste sentido que a modelagem compu-
tacional se insere como uma ferramenta poderosa, além
de ser aliada ao desenvolvimento científico.

O uso de ferramentas interativas que permitem a in-
serção de dados pelo usuário para visualização do com-
portamento de sistemas físicos tem sido usado na conso-
lidação do conhecimento. A simulação criada por modelo
a partir do GUIDE do MATLAB é usada na análise da
propagação de ondas de tensão em uma linha de trans-
missão [5]. O JARVES juntamente com o OpenFOAM é
empregado na simulação de fluidinâmica [6]. A simulação
computacional via cálculo de soluções numéricas é muito
empregado em problemas clássicos de transmissão de ca-
lor [7]. Não obstante, o Java tem sido usado na animação
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de modelagem via software Modellus para simples estudo
qualitativo de hidrostática [8].

A aplicação desse tipo de metodologia no estudo de
materiais magnéticos, por exemplo, torna-se bastante
útil quando o primeiro e único contato com a teoria, por
parte do estudante, frequentemente se dá através de uma
abordagem que envolve apenas conceitos das principais
propriedade magnéticas sem a realização de simulação ou
experimentação [9,10]. O estudo de materiais magnéticos
está em evidência nos últimos anos pois estes desem-
penham um papel muito importante tanto no aspecto
científico quanto tecnológico. Por exemplo, materiais su-
perparamagnéticos são importantes no desenvolvimento
de fármacos para tratamento de câncer [11–13], dentre
inúmeras outras aplicações. Alguns trabalhos tem ido
nessa direção ao tratar de sistemas magnéticos nanoes-
truturados voltado ao ensino da Física, o que abre portas
para uma gama de possibilidades [14,15].

Neste artigo, apresentamos um software intitulado SP-
mag Tools 1.0, desenvolvido com o objetivo de proporci-
onar uma visão do comportamento de sistemas superpa-
ramagnéticos sujeitos a campos magnéticos externos por
meio de simulações que reproduzem o comportamento
da magnetização em função de diversas variáveis, tais
como temperatura, magnetização de saturação e diâme-
tro médio dos momentos magnéticos.
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2. Fundamentos do Magnetismo

Na presente seção apresentamos os fundamentos do mag-
netismo de interesse uma vez que, para compreender o
comportamento superparamagnético (Seção 2.3), é inte-
ressante o entendimento de outros dois comportamentos
que aparecem parcialmente nos materiais superparamag-
néticos; o paramagnetismo e o ferromagnetismo.

2.1. Paramagnetismo

Uma vasta gama de íons magnéticos apresenta um com-
portamento de interação entre íons vizinhos extrema-
mente fraco, considerando-se inexistente o acoplamento
de seus momentos magnéticos, deixando os mesmo com
orientações aleatórias. Estes materiais configuram-se em
um estado paramagnético. Eles apresentam uma grande
sensibilidade magnética a aplicação de um campo magné-
tico externo, que tende a alinhar os momentos magnéticos
tornando suas magnetizações diferentes de zero. Entre-
tanto, quanto maior a temperatura à qual o material
encontra-se exposto, maior a agitação térmica que tende
a desalinhar seus momentos magnéticos; é uma espécie de
competição entre energia magnética, oriunda do campo
magnético externo, e a energia térmica [16,17].

Um sistema paramagnético pode ser representado por
um ensamble canônico. Supondo que o campo magnético
externo seja aplicado na direção do eixo Z , a energia
de interação dos dipolos magnéticos de cada íon com o
campo assume 2J + 1 valores quantizados, com o nú-
mero quântico magnético mz variando de −j ≤ mj ≤ j,
sendo J o momento angular orbital. Assim, a função
de partição de cada íon independente é dada por Zi =∑j

mz=j exp(−εj/kBT ), na qual a energia do estado quân-
tico de um orbital pode ser escrita como εj = −mjgµBH
quando submetido a um campo magnético. Nesta situa-
ção, o momento magnético médio é µ = kBT (∂lnZi/∂H).
Observa-se que a função de partição trata da soma dos
termos de uma progressão geométrica. Com isso, pode-
mos determinar a magnetização total de um sistema
paramagnético multiplicando o momento magnético mé-
dio pelo número de íons por unidade de volume. Desta
forma temos

MP M
∼= NgJµBBJ(X), (1)

onde, g é a constante denominada fator giromagnético de
Landé e BJ (X) é conhecida como a função de Brillouin,
a qual é dada por

BJ(X) =
(

2J + 1
2

)
coth

(
(2J + X)

2J

)
−

1
2J

coth
(

X

2J

)
, (2)

onde, X = gJµBH/kBT é a razão entre a energia de in-
teração do momento magnético com o campo, e a energia
térmica.

Observa-se que a grandeza X é adimensional, caso
considerarmos X � 1 obtemos BJ (X) = 1. Essa situação
é existente quando o sistema magnético está exposto a um
campo magnético à baixa temperatura e/ou alto campo.
Nestas condições a magnetização do sistema tende a um
valor de saturação. Consequentemente, temos

MP M = MSBJ(X), (3)

onde a magnetização de saturação é dada por MS =
NgJµB .

Normalmente, considera-se as condições em que são
realizadas medições em paramagnetos como sendo ”nor-
mais”e ”moderadas”, quando a temperatura de medição é
próxima da ambiente e o máximo valor do campo aplicado
encontra-se na faixa entre 5000 e 10000 Oe, respectiva-
mente. Ou seja, as medições são realizadas em regiões
das curvas de magnetização que possuem comportamento
aproximadamente linear [18]. Neste caso, podemos con-
siderar um X muito pequeno e expandir coth(X), da
função de Brillouin, em série de Taylor até segunda or-
dem e teremos sua substituição por (1/X + X/3), logo,
teremos BJ(X) = (J + 1)X/3J . Portanto, a magnetiza-
ção paramagnética nestas condições é dada por

MP M ≈ Ng2µBJ(J + 1)H
3kbT

. (4)

Outra forma de caracterização magnética pode ser
realizada por meio de análise da sensibilidade da mag-
netização de um sistema a um campo magnético apli-
cado, chamada susceptibilidade magnética, χ = ∂M/∂H .
Nesse contexto, considerando a Equação (4) podemos
representar a susceptibilidade magnética como sendo

χ = Ng2µBJ(J + 1)
3kBT

. (5)

Observando a Equação (5), verifica-se que apenas a
temperatura é variável, sendo constante a quantidade
C = Ng2µBJ(J + 1)/(3kB), conhecida como constante
de Curie. Sendo assim, a susceptibilidade recíproca dos
paramagnetos varia linearmente com a temperatura, Lei
de Curie, dada por χ = C/T .

Estas relações aqui expressas são válidas para sistemas
em regime paramagnético típico, não obstante, mediante
algumas modificações, são também válidas para sistemas
ferromagnéticos, ferrimagnéticos e antiferromagnéticos
acima de certa temperatura crítica. Isso ocorre quando
a agitação térmica é alta o suficiente para vencer o aco-
plamento existente entre os momentos magnéticos, em
outras palavras, quando os momentos magnéticos do sis-
tema passam a ter orientação aleatória entre si devido à
alta energia térmica.

2.2. Ferromagnetismo

Nesta seção, inicialmente vamos apresentar um comporta-
mento experimental típico em sistemas ferromagnéticos,
a conhecida curva de histerese magnética. Os momen-
tos magnéticos de um sistema ferromagnético tendem
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a se acoplar entre si formando regiões no interior do
material dentro das quais todos se encontram alinha-
dos em uma mesma direção e sentido. Tais regiões são
chamadas de domínios magnéticos. Quando um campo
magnético externo é aplicado sobre o material, as su-
perfícies fronteiriças entre tais domínios, denominadas
paredes de domínio, começam a ser mover à medida em
que o campo aplicado aumenta, de forma a maximizar
o volume dos domínios cujos momentos de dipolo já se
encontravam relativamente bem alinhados com o campo
aplicado e a diminuir o volume daqueles cujos momentos
de dipolo não se encontravam favoravelmente alinhados
na direção do mesmo. A magnetização do sistema irá
aumentar até que os momentos magnéticos presentes
em todos os domínios se encontrem com o melhor ali-
nhamento possível em relação ao campo aplicado. Este
valor de magnetização é chamado de magnetização de
saturação (MS). No entanto, partindo da situação ante-
rior e decrescendo este campo até zerá-lo, a trajetória
descrita pela curva de desmagnetização não é a mesma
que a descrita quando o campo aplicado foi aumentado
(curva de magnetização). Isso ocorre porque os movimen-
tos das paredes de domínio são frequentemente detidos
por defeitos na estrutura cristalina do material, dando
origem ao que chamamos de histerese magnética. Isso
significa que o material possui uma memória magnética,
também conhecida como magnetização remanente (MR).
Para zerar esta remanência magnética é necessário que
se aplique um campo magnético de certa intensidade no
sentido contrário ao inicial, conhecido como coercivo ou
coercitivo (HC). Caso o campo aplicado extrapole o valor
do campo coercivo, a magnetização aumentará progressi-
vamente no sentido oposto até atingir a saturação. Para
zerar novamente a magnetização basta fazer o processo
inverso, com isso, alternando o campo magnético de altos
valores de um sentido para outro, ver-se-á uma curva de
histerese sendo delineada pela trajetória da magnetização
da amostra em função do campo magnético aplicado.

Nos materiais ferromagnéticos, a Lei de Curie perde
sua validade, pois seus momentos de dipolo magnéticos
apresentam interação de troca positiva entre vizinhos
favorecendo o alinhamento em direções e sentidos iguais.
Entretanto, assim como em sistemas paramagnéticos, o
comportamento ferromagnético é dependente da tempera-
tura, uma vez que a agitação térmica é capaz de suplantar
o acoplamento magnético. Portanto, considerando o men-
cionado na Sec. 2.1, o comportamento ferromagnético só é
observado em temperaturas abaixo de certa temperatura
crítica TC .

Weiss [19] propôs uma teoria com pressupostos clássi-
cos. De forma sucinta, foi o primeiro a propor que nos
sistemas ferromagnéticos os momentos magnéticos estão
completamente alinhados dentro de certas regiões que fi-
caram conhecidas como domínios de Weiss. Em sua teoria,
considerou a presença de um campo magnético interno
extremamente forte nestes domínios, cuja origem está
na interação entre os spins atômicos, o qual denominou
campo molecular Hm, o qual pode ser descrito de forma

simples como sendo Hm = NwM , sendo Nw conhecida
como constante molecular de Weiss. Weiss substituiu o
campo H aplicado externamente no caso paramagnético
por um campo efetivo Hef dado pela soma do campo
aplicado em certa direção Hext com o campo molecular
interno Hm. Com isso, considerando a Equação (3) e
substituindo o argumento X da função de Brillouin por
Y , definido por Y = gJµB(Hext + NwM)/kBT , obtemos
a seguinte expressão:

M

MS
= gµB(J + 1)

3kB

Hext + NwM

T
. (6)

Utilizando a mesma analogia considerada na obten-
ção da Equação (4), porém, considerando o efeito do
campo molecular, podemos descrever da Equação 6 a
magnetização como sendo

M = TCH

Nw(T − TC) , (7)

onde TC é a temperatura crítica ou temperatura de Curie,
a qual é dada por TC = gµB(J +1)NwMS/3kB . Portanto,
a curva de magnetização para os sistemas ferromagnéticos
decai com o aumento da temperatura, sendo válidas as
equações acima para temperaturas inferiores a TC , pois
acima desta, o comportamento do sistema magnético
passa a ser paramagnético, como dito anteriormente.
Não obstante, fazendo uma analogia com a Lei de Curie
do paramagnetismo, a susceptibilidade magnética de um
ferromagneto, em temperaturas acima de TC é dada pela
Lei de Curie-Weiss:

χ = ∂M

∂H
= C

T − TC
, (8)

onde C = TC/Nw. Observa-se que a Equação (8) é válida
apenas para T > TC .

Uma metodologia utilizada por pesquisadores que bus-
cam interpretar o comportamento magnético destes siste-
mas via medidas de magnetização em função da tempe-
ratura é representando graficamente o inverso da suscep-
tibilidade em função da temperatura. Quando os dados
interceptam o eixo da temperatura na origem, o sistema
apresenta um comportamento paramagnético (Lei de Cu-
rie); e quando interceptam em certo valor positivo de
temperatura (TC), o sistema apresenta um comporta-
mento ferromagnético (Lei de Curie-Weiss).

2.3. Superparamagnetismo

Em 1930, Frankel e Doefman [20] apresentaram um traba-
lho pioneiro sobre o estudo de amostras magnéticas com
tamanhos nanométricos. Mostraram que abaixo de certo
tamanho crítico de partícula, energeticamente é mais
favorável que as partículas apresentem um único domínio
magnético, chamado monodomínio magnético. Posteri-
ormente, muitos trabalhos consideraram e aprimoraram
este trabalho. Podemos destacar o estudo de Néel [21] de
1949, no qual mostrou uma grande importância da flutu-
ação térmica capaz de alterar a direção dos momentos
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magnéticos, desde que a energia térmica kBT seja sufi-
ciente para superar a barreira de energia de anisotropia
magnética destes domínios magnéticos, desconsiderando
a relaxação temporal [22,23]. Quando isso acontece, estes
materiais se comportam de forma similar aos paramagné-
ticos. Entretanto, quando a energia térmica é da ordem
da energia de anisotropia, uma curva similar à função
de Brillouin começa a surgir devido à lenta reorientação
dos domínios magnéticos, mas não pode ser representada
pela mesma 1. Logo, quando a energia térmica é inferior
a energia de anisotropia magnética, surge remanência
e coercividade magnética, ou seja, o loop de histerese
se torna evidente. Estes materiais foram nomeados por
Bean e Livingston [24] como superparamagnéticos.

As partículas de um sistema superparamagnético são
compostas pelo agrupamento de pequenos momentos
magnéticos na forma de domínios magnéticos não inte-
ragentes. Estes agrupamentos podem ser formados por
multi ou monodomínios magnéticos. Quando as partí-
culas possuem um tamanho significativo, estes agrupa-
mentos podem ser divididos em dois os mais grupos com
interfaces entre vizinhos que tornam a mudança de orien-
tação gradual, pois ocorre o favorecimento da formação
das paredes de Bloch, estes são os multidomínios. Entre-
tanto, quando as partículas possuem um tamanho muito
reduzido, abaixo de um volume crítico, a formação das pa-
redes de Bloch é desfavorecida energeticamente tornando
as direções de magnetização dos momentos alinhadas
em um único sentido, ou seja, formam-se monodomínios
magnéticos 2.

De modo geral, em um sistema superparamagnético
monodomínio, a energia de interação de troca entre os
momentos magnéticos de uma partícula é muito maior
que a energia térmica. Logo, a energia térmica é muito
maior que as possíveis energias de interações dipolares
clássicas entre as partículas. Matematicamente isso pode
ser expresso da seguinte maneira:

|Jint| � kBT � |Jext|. (9)

Com isso, podemos representar este tipo de sistema tendo
domínios interagindo internamente de forma ferromagné-
tica, mas entre si, interagindo paramagneticamente.

Supondo que uma partícula superparamagnética pos-
sui em seu interior momentos magnéticos que se com-
portam de forma análoga, acoplados uns com os outros,
podemos considerar que cada partícula possui um mo-
mento de dipolo total dado pela soma dos momentos
magnéticos moleculares (ou atômicos) em seu interior,
µ = µatN , sendo µat o momento magnético de cada íon
e N o número de íons presentes na partícula. Portanto,
o comportamento da magnetização total de um sistema
1A função de Brillouin representa curvas M(H) para sistemas para-
magnéticos, sendo J da ordem do momento angular total do íon
magnético. Entretanto, com base nesta função obtém-se uma apro-
ximação clássica para função de Langevin, a qual descreve estas
curvas para sistemas superparamagnéticos, que será apresentada
em breve.
2O tamanho crítico é aquele de dimensões da ordem das paredes
de Bloch do sistema.

superparamagnético submetido a um campo magnético
externo pode ser representado pela aproximação da Equa-
ção 1 considerando J → ∞,

MSP M = lim
J→∞

MP M , (10)

ou seja,

lim
J→∞

BJ (X) = lim
J→∞

BJ

(
gJµBH

kBT

)
=

coth
(

µH

kBT

)
− kBT

µH
. (11)

Observando a equação obtida, percebe-se que se trata da
equação de Langevin, ou seja,

L(x) = coth (x) − 1
x

. (12)

Logo, a magnetização total de sistemas superparamag-
néticos é, expressa em função da equação de Langevin,
dada por

MSP M = MSL

(
µH

kBT

)
. (13)

3. Software SPmag Tools 1.0

comportamento de sistemas superparamagnéticos pos-
suem dependência de variáveis, como, temperatura, mag-
netização de saturação e diâmetro médio dos momen-
tos magnéticos. Logo, as curvas de magnetização po-
dem ser obtidas utilizando a Equação 13 considerando
µ = MSπ DM

3

6 . Para avaliar o comportamento magnético
de sistemas superparamagnéticos no regime desbloqueado
desenvolvemos o software SPmag Tools 1.0. O software
permite realizarmos simulações de curvas de magnetiza-
ção com diferentes variáveis.

O desenvolvimento do software foi em linguagem JAVA
1.8 com a ferramenta JavaFX 8. Para o ambiente de
desenvolvimento utilizamos o Netbeans IDE por ser inte-
grado e gratuito, sendo executado em muitas plataformas.
Para ajudar a visualizar o caminho de desenvolvimento
aplicamos o uso da Unified Modeling Language. O design
foi realizado por código Cascating Style Sheet que o pró-
prio JavaFX disponibiliza e que pode ser obtido pelos
documentos da Oracle (JavaFX CSS Reference Guide).

Na Fig. 1 mostramos uma operação no SPmag.
Ao explorar o SPmag pela primeira vez o usuário

poderá acessar o Help → Quick Tutorial e terá a opção
de fazer um pequeno passeio direcionado autoexplicativo
pelas principais operações do software. Em File terá a
opção New Input Control File na qual poderá iniciar
um novo projeto de visualização (Vizualization Project)
de curvas de Langevin (Langevin Curves). Ao acessar a
opção descrita poderá nomear a curva a ser realizada em
Curve Title e parametrizar os valores de temperatura,
diâmetro médio e magnetização de saturação da curva
recém intitulada, observando que os valores inseridos
deverão estar no SI. Em seguida poderá delimitar os
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Figura 1: Interface do software SPmag Tools 1.0.

valores de campo magnético no intervalo e incremento
desejado em From, To e Increment, respectivamente.
Logo, ao clicar em Run, no cabeçalho do software, terá a
geração da curva desejada. O usuário poderá gerar novas
curvas, basta alterar o título da curva e os parâmetros e
clicar em Apply.

As curvas podem ser editadas gráficamente, basta se-
lecionar a curva gerada em Curve e escolher as opções
de tipo de símbolo, linha e cor, e ao final da escolha
clicar no Apply ao lado. Observa-se que a esquerda deste
Apply possui a opção Delete que tem a função de remover
alguma curva indesejada, bastando para isso selecionar
a curva nesta opção e aceitar sua remoção. Construída
uma série de curvas o usuário poderá salvar os dados
no mesmo momento que os exporta, pois, ao salvar em
File → Save as, será gerado um arquivo em formato .txt
que conterá todas as informações das curvas geradas. O
arquivo salvo poderá ser novamente aberto no SPmag
em File → Open Input Control File e reeditado, além de
que pode ser usados em outros softwares de tratamento
de dados.

4. Análise da Função de Langevin

O comportamento da magnetização pode ser simulado
com variações dos parâmetros realizando diferentes cur-
vas como mostram os resultados na Fig.2 via SPmag.

Na Fig.2(a) fixamos os valores de MS = 2×103 A/m e
DM = 10×10−9 m e variamos os valores de T para o inter-
valo entre 2–300 K. Utilizamos o menor valor de 2 K para
temperatura, pois esse é aproximadamente o menor valor
de temperatura medida por aparelhos convencionais de
medidas magnéticas. Logo, observamos claramente a de-
pendência da magnetização com a temperatura. Quanto
menor a temperatura, mais rapidamente o sistema atinge
a saturação. Isso ocorre por se tratar de uma competição
entre ordenamento, ocasionado pelo campo magnético,
e o desordenamento, ocasionado pela temperatura. Ou
seja, necessita-se menor campo magnético para saturar
um sistema em baixas temperaturas.

Na Fig.2(b) fixamos os valores de T = 300 K e DM =
10×10−9 m e variamos os valores de MS para o intervalo

Figura 2: Simulação da função de Langevin com variação da
(a) temperatura, (b) magnetização de saturação e (c) diâmetro
médio.

entre 2–7 × 103 A/m. Neste caso, observamos que as
curvas tem mesmo comportamento, tendendo para satu-
ração de cada respectiva curva, e isso pode ser evidente
fazendo uma normalização da magnetização de todas as
curvas, i.e. dividindo todos os dados de cada curva por
seu valor máximo de magnetização, assim elas ficariam so-
brepostas. Logo, a magnetização de saturação não altera
o formato das curvas de magnetização, apenas saturam
a seus valores. Isso também pode ser observado junto a
Equação 13, na qual observa-se que MSP M ∝ MS .

Na Fig.2(c) fixamos os valores de T = 300 K e MS =
2×103 A/m e variamos os valores de DM para o intervalo
entre 10–35×10−9 m. Observamos que ao aumentar o di-
âmetro médio a magnetização tende abruptamente para
o valor da saturação, ou seja, partículas maiores estão
mais susceptíveis ao ordenamento magnético. Entretanto,
observando no sentido oposto, ao diminuir o diâmetro
médio a tendência das curvas é perder o comportamento
clássico da curva de Langevin e tendendo ao comporta-
mento linear por ampla faixa de campo magnético. Isso
pode ser comparado a partículas pequenas com momen-
tos de dipolos pequenos que tendem ao comportamento
paramagnético. Isso mostra a correta associação do mo-
delo do superparamagnetismo onde temos o limite de
J −→ ∞ da função de Brillouin, discutido na 2.3.

Caso fossem escolhidos outros valores de diêmetro mé-
dio, poderíamos perceber muita semelhança entre algu-
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mas curvas. Isso ocorre devido a dependência mútua
entre temperatura e tamanho de constituintes no pro-
cesso de magnetização, pois maior o diâmetro e menor
a temperatura, mais rapidamente atingisse a saturação
magnética.

Experimentalmente, dada certas condições existe a
possibilidade da curva não alcançar a saturação (ou ten-
dência de saturação) podendo ser interpretado como a
presença de partículas paramagnéticas contidas no sis-
tema. Isso pode ocorrer devido a questões experimentais
da coleta de dados, i.e. intervalo de campo magnético
pequeno. Neste momento, ajusta-se uma reta na região
de campos mais altos que representaria a presença da con-
tribuição paramagnética e desconta-se esta contribuição
de todos os pontos experimentais, para que a curva passe
a ser representada saturada. Logo, isso é o mesmo que
associar simultaneamente a função de Brillouin do para-
magnetismo com uma função de Langevin. Entretando,
devemos estar atentos aos comportamentos possíveis das
curvas de magnetização para que não ocorrem interpreta-
ções errôneas nos dados. Entretanto, outras técnicas de
caracterização associadas as medidas magnéticas podem
auxiliar na interpretação do sistema magnético.

5. Conclusão

A partir de uma revisão do conceito de superparamagne-
tismo desenvolvemos o software SPmag Tools 1.0 com o
qual podesse realizar simulações das curvas de magnetiza-
ção de forma rápida, sem a necessidade de conhecimento
em programação.

O software desenvolvido constitui uma importante fer-
ramenta para consolidação dos conhecimentos acerca do
comportamento da magnetização de sistemas superpara-
magnéticos no regime desbloqueado sujeitos a campos
magnéticos externos. Ressalta-se que a possibilidade de
análise de variáveis é um importante acréscimo como
apoio didático.

O superparamagnetismo, apesar de ser estudado a mui-
tos anos, ainda possui muitos aspectos inexplorados e
esperamos que este artigo possa incentivar os leitores
ao aprofundamento no estudo destes materiais magnéti-
cos. Logo, o software é livre e pode ser encontrado gra-
tuitamente no endereço http://gca.unijui.edu.br/
downloads/bd818e51323107fb230b931c99e77f56.exe
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